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Limitations on Maintenance Services

The FactorSoft™ application is intended for use in accordance with the standards and processes described within this
documentation. Efforts to investigate and/or repair FactorSoft™ application or data integrity issues caused by activ-
ities or integrations outside of the intended use of the FactorSoft™ platform will be subject to the then-current Jack
Henry Professional Services billable hourly rate.

Standard Maintenance Services (Technical Support) does not include the following:

Investigation and Remediation of errors and data integrity issues caused, contributed to, or by any of
the following:

n a software program that was not originally provided by Jack Henry

l third-party automation, BOT/Screen Scraping technology, custom importers,
or any other integration with FactorSoft™ that was not created by or in con-
junction with Jack Henry.

n any modification not provided by Jack Henry to the software or standard database
schema

l the addition of custom database elements including triggers, stored pro-
cedures, tables, and columns

l the alteration of standard FactorSoft™ triggers, tables, columns, stored pro-
cedures and indexes

l the execution of T-SQL scripts resulting in changes to the data stored within
the FactorSoft™ database

n equipment, software, networks or any other infrastructure in the customer’s envir-
onment that does not meet the minimum requirements described within the then-
current FactorSoft™ product documentation

Please note that if you are exploring possibilities with third-party software providers or considering altering the FactorSoft database
in any way, it is strongly recommended that you discuss your plans with the FactorSoft™ support team before making any com-
mitments or changes. As your software partner, we may be able to help solve your business problem in a way that does not intro-
duce risk, data corruption, or system instability.
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Invoice Delivery

Invoice Delivery is an AddOn module to FactorSoft that enables cover pages, notice of assignment doc-
uments, and invoice and supporting document images to be delivered to the debtor at invoice purchase.
Invoice Delivery is enabled through the Engine, which allows flexibility in determining when packages are
delivered. In addition, Invoice Delivery provides the ability to reproduce delivery packages.

Features of Invoice Delivery include:

l Enabled through the Engine to allow flexibility in invoice package delivery

l Customized package cover page and email subject and messages

l Additional debtor-level document can be included in package

l Capability to force delivery on batches with unattached images

l Capability to resend package

l Bypass Invoice Delivery for a specific batch

l Monitor batch-level Invoice Delivery status

l Capability to use customized cover page

Invoice Delivery Setup

This section shows you how to set up Invoice Delivery in FactorSoft. The setup requirements are:

l Activation

l Set System Preferences

l Set Custom Cover Page

l Set Outsourced Printing

l Set Service and Engine Task

SEPARATELY LICENSED ADD-ON MODULE

This feature is only available as a separately licensed upgrade.
For more information, contact your Jack HenryTM representative at lendinginfo@jackhenry.com
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System Preferences

CAUTION
Jack Henry™ recommends that the Engine services be stopped and restarted any time Invoice Deliv-
ery System Preferences are changed.

Set the following option in Data entry behavior, Invoice Delivery folder.

Preference Description

Folder location for
completed Invoice
delivery packages

The fully qualified path and folder location in which the Engine saves completed
Invoice Delivery packages.

Use daily folders for
invoice delivery

Set to Yes to instruct FactorSoft to create daily folders within the Folder location
for completed Invoice delivery packages at date change.

Number of days
before the invoice
delivery packages
are purged

Set to the number of days after which to purge package files. Package files with
file dates older than the current processing date less the number of days set in
the preference are automatically deleted from the folder and also removed
from the Documents screen on the Web Portal.

Message Text Enter the entry name from the Statement Texts table to be used for the body
text of the email message.

Subject line Enter the text to be displayed in the subject line of the email message.

If blank, the subject line will omit the semi-colon (;) from the Subject Line Rule
below.

Subject line rule Select the option that determines additional data included in the subject line
when Instructs the engine to send one email per invoice is set to True.

Invoice Delivery User Guide
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Preference Description

l Invoice number

l Purchase order number if available

Note: If there is no Purchase Order number, the system will use the Invoice num-
ber instead.

l Invoice number and purchase order number if available

l Invoice number and batch number

l Purchase order number and Batch number

Note: If there is no Purchase Order number, the system will use the Invoice num-
ber instead.

Subjects will display as follows: “ Subject Line; Subject Line Rule”

Invoice number and purchase order number if available Example:
Your Subject Line; Invoice #51921-3 - Purchase Order #51921-po3

If Instructs engine to send on email per invoice = FALSE then the email sub-
ject line will honor Subject Line (Free Form Text); Batch # - Invoices.

Example: Your Subject Line; Batch#1951 - Invoices

Include notice of
acknowledgment if
available

Set to True to include a notice of acknowledgment with each invoice delivery if
a document is available in the NOA category of the Document pane of the
Debtor Information screen for the debtor or the Documents tab of the Client
Information screen for the relationship.

Include all invoices Set to True to deliver all invoices regardless of status as part of the invoice pack-
age to each debtor.

Include denied
invoices if available

Set to True to allow denied invoices to be delivered as part of the invoice pack-
age to each debtor.

Include held invoices
if available

Set to True to allow held invoices to be delivered as part of the invoice package
to each debtor.

Instructs the Engine to
send one email per
invoice

Set to True to send individual emails for each invoice in a batch with associated
images and documents attached. If set to False, all invoices, images, and doc-
uments are included in as few emails as size restrictions set in System Prefer-
ence Instructs the engine to limit the size (Kb) of each email allow.
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Preference Description

If True, the email subject line will display the above system preferences for Sub-
ject Line; Subject Line Rule. If False, the email subject line displays the above sys-
tem preference for Subject Line; Batch# associated to the Invoice Delivery
Package.

Instructs the engine
to ignore supporting
documents as attach-
ments

Set to True to exclude images marked as Support from being emailed through
Invoice Delivery. Send one email for all invoices in a particular batch with an
attachment that includes the cover page, assigned images (Invoices Only) and
any written invoices.

Instructs the engine
to limit the size (Kb) of
each email

Set to the maximum attachment file size in kilobytes. Jack Henry™ recommends
that this preference be set to 2048 kb. Note that the setting of this preference on
the email server will take precedence over a conflicting setting on a desktop cli-
ent instance of FactorSoft.

If the attachment does not exceed the maximum size, send one email to the
debtor for all invoices in a particular batch with an attachment that includes
the cover page, assigned images (Invoices and Supporting documents) and
any written invoices.

If the attachment exceeds the maximum size defined in this system preference,
send multiple emails to the debtor. The first email will have a subject of “Invoice
and backup - Invoices 1 of 4,“ and include the cover page, assigned images,
and written invoices. Additional emails will have a subject of “Invoice and
backup - Invoices 2 of 4,” “Invoice and backup - Invoices 3 of 4,” and so on, and
each include an attachment file of assigned images until the delivery is com-
plete.

Instructs the engine
to create a log file in
the users temporary
file

Set to True to create a log file for in the Windows temporary folder for the user.
Jack Henry™ support recommends setting this option to True.

Instructs the engine
to limit the number of
batches to process
during one task inter-
val

Set this preference to the maximum number of batches to process in one task
interval. This preference is a troubleshooting tool for use by Jack Henry™ sup-
port and should be set to zero during normal operation, which indicates that no
limit is set on the number of batches that can be processed in a task interval.

The remote printer
name for invoice
delivery printing

Select the remote printer (previously configured on Print) on which to print the
Invoice Delivery packages for entities that have the printing preference set to
Print.
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Preference Description

Write cover page
using SQL reporting
services

Set to True to use Reporting Services to write the Invoice Delivery package
cover page.

The following system preferences for this function are found in the Administration module, System Prefer-
ences, Identification/system constants, Performance, Messaging folder.

Preference Description

Combine multiple
images into single
PDF

Set to True to instruct FactorSoft to combine all images into a single PDF doc-
ument for emailed Invoice Delivery packages.

Messaging folder Enter the fully qualified path to the folder in which the attachment files are writ-
ten. Note that the Engine requires full rights to this folder.

Purge days for attach-
ment files to be
deleted from the mes-
saging folder

Set to the number of days after which to purge attachment files. Attachment
files with file dates older than the current processing date less the number of
days set in the preference are automatically deleted from the messaging
folder.

Jack Henry™ recommends setting this preference to 14 days.

The following system preference for this function are found in the Administration module, System Prefer-
ences, Reports, Purchase report folder.

Preference Description

Print cover pages for
purchases

Set to True to indicate that Invoice Delivery attaches the cover page set in
Cover page report module for invoices with images.

Setting Up Custom Cover Pages

The following system preferences in the Data entry behavior, Invoice Delivery, Coverpage Settings
folder must be defined.

Preference Description

Cover page report
module

Enter the name of the report module that is used to print the cover page. If this
setting is blank, cover pages are not printed.

To use a custom cover page, this system preference must be defined as

Invoice Delivery User Guide
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Preference Description

COVERPAGECUSTOM.

Cover page, number
of invoices per page

Enter the number of detail lines per page. Detail lines are automatically set to 23
but can be changed if needed.

Cover pages are for
invoices with images
only

Set this system preference to True or select the Cover pages are for invoices
with images only check box to indicate that cover pages are only used for
debtors with invoices that include images.

Cover page date
format

Enter the date format used when displaying the date on the cover page.

Cover page show Cli-
ent# / Batch#

Enter whether the client number, the batch number, both the client and batch
number, or neither number displays on the cover page.

Cover page heading
text

Enter the text that displays in the heading section of the cover page.

Cover page hide
page count

Set this system preference to True or select the Cover page hide page count
check box to hide the page count on the cover page.

Cover page payment
language text

Enter the payment language option to define the payment text that display on
the cover page.

Payment language options are defined on the Statement Text Table screen in
the Tables module.

Cover page state-
ment text

Enter the payment language option to define the payment instructions that dis-
play on the cover page.

Payment language options are defined on the Statement Text Table screen in
the Tables module.

Cover page lender
address

Select the option corresponding to which lender address to use on the cover
page.

The logo image name
for the invoice deliv-
ery cover page

The name of the .jpeg image file to be displayed as a logo image on the Invoice
Delivery cover page (default of custom). The logo image must be saved as a
.jpeg or .jpg image file. The System Preference requires the entry of the image
file name (but not the path), and must contain the .jpeg or .jpg extension. The
file must be saved in the folder specified in System Preference Iden-
tification/system constants, Identification/system constantsReporting Ser-
vices, Folders, Folder for Report parameters.
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Preference Description

Watermark invoices
message

Select the statement text name to use as the annotation/watermark text. The
statement text names are set up in the Statement Text Table in the Tables mod-
ule.

Note that this preference is the same as the Client rules/defaults, Defaults,
Data entry, Watermark invoice message preference. Setting either of these
preferences sets the other to the identical value.

Watermark invoices
position

Select the position on the invoice image at which to place the annota-
tion/watermark text:

l Center

l Center Left

l Center Right

l Top Left

l Top Center

l Top Right

l Bottom Left

l Bottom Center

l Bottom Right

Watermark text font
size

Set the font point size for the annotation/watermark text. It is recommended to
keep this value between 12 and 35.

Watermark text color Select the font color for the annotation/watermark text:

Invoice Delivery User Guide
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Preference Description

l Black

l Grey

l Blue

l Green

l Red

l Yellow

l Orange

Watermark opacity Enter the opacity level for the watermark on the cover page. Values are
between 0.3 and 1 with 1 being 100% full saturation. It is recommended to keep
this value low in the event it is positioned over text on the invoice.

The lower the number, the more transparent the watermark is on the cover
page.

Setting Up Outsourced Printing

The following system preferences in the Data entry behavior, Invoice Delivery, Outsourced Printing
folder must be defined.

Preference Description

Outsourced printing
cover page

Set this system preference to True to export invoice delivery packages to the
third-party printing service.

Outsourced printing
export folder

Enter the file patch for the folder containing the invoice delivery packages to be
exported to the third-party printing service.

Outsourced printing
email subject

Enter the subject line for emails sent to the third-party printing service.

Outsourced printing
email body

Enter the body content for the email sent to the third-party printing service.

Outsourced printing
email address

Enter the email address for the third-party printing service.

Invoice Delivery User Guide
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Engine and Service Tasks

Invoice Delivery will not function if these components are not correctly configured.

CAUTION
Jack Henry™ recommends that the Engine services be stopped and restarted any time Invoice Deliv-
ery System Preferences are changed.

Engine Task

The Engine enables the Delivery Verification functionality. The Engine task type Invoice Delivery must be
enabled and assigned to a Task Server Load entry in the Engine Administration module. The Invoice Deliv-
ery Engine task type should be set up to execute within an exclusive Task Service, as the Task Service may
hang up if combined with Crystal Reports executions. The Invoice Delivery task should also have a priority
of 9 and its thread limit set to 1.

With these settings, the task type is automatically processed in real time at short intervals. If you would
like to turn off the task from automatically processing during a specific time period, such as on weekdays
from 5 AM to 7 PM so that images can be scanned during business hours, the following steps can be
taken.

For more details about the Engine Administration module, see the Engine Administration chapter in the
FactorSoft Administrators Guide.
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1. Select Task Server Load in the Database Settings menu of the Engine Administration module.

2. Click the plus sign for the Task Server Load set up for the Invoice Delivery task type.

The Task Server Load Shift tab is displayed for the Invoice Delivery task, as illustrated below:

3. Set the Task Server Load Shift as follows:

Column Description

Override Is Enabled Do not select this option. This option instructs the Engine to enable the
task during the hours set up for the load shift.

Hour Begin Set to “7”

Setting is in military time (7 = 7 AM)

Hour End Set to ”17”

Setting is in military time (17 = 5 PM)

Days of the Week Set to “NYYYYYN”

This is a string of seven characters representing the seven days of the
week, Sunday through Saturday.

Override Max Con- Set to “0”

Invoice Delivery User Guide
Invoice Delivery

10 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Column Description

current

Enabled Select this option to instruct the Engine to turn off the task during the
hours set up for the load shift.

4. Click the Save Changes button.

The changes are saved and the task is overridden and does not process from 7 AM to 5 PM.

Client Information - Invoice Delivery Panel

Client Information Set-up

Invoice Delivery is enabled at the client-level on the Invoice Delivery panel of the Client Information
screen.

The Invoice Delivery panel is used to enable Invoice Delivery for the client, and to assign the client-level
blanket Notice of Assignment (NOA) letter to be sent with the Invoice Delivery package for each cli-
ent/debtor relationship, rather than manually attaching the NOA to each relationship.

SEPARATELY LICENSED ADD-ON MODULE

This feature is only available as a separately licensed upgrade.
For more information, contact your Jack HenryTM representative at lendinginfo@jackhenry.com

Field Description

Send images and
cover pages on pur-
chase

Select this Invoice Delivery messaging option to indicate that cover pages and
images are delivered to the debtor at invoice purchase for this client.

NOA document Select the NOA document to send via Invoice Delivery to each debtor with which
the client has a relationship. This is the client document that will be sent based
on the NOA document rule setting (the relationship level document is assigned
in the NOA Document field on the Documents tab of the Debtor Aging screen
for the relationship). The documents available in this list are associated to the
client in the General category in the Documents panel of the Client Information
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Field Description

screen.

NOA document rule Select the rule that determines whether an NOA document is sent with the
Invoice Delivery package, and if so, whether the document to be sent is determ-
ined at the client or relationship level.

l Do not send: do not send NOA documents with the Invoice Delivery pack-
age

l Send from relationship, if available: send the document assigned to the
relationship on the Documents tab of the Debtor Aging screen if available
for the relationship, otherwise do not send an NOA document with the
Invoice Delivery package

l Send from client, if available: send the document assigned to the client
on the Invoice Delivery panel if available, otherwise do not send an NOA
document with the Invoice Delivery package

l Send from relationship, if available, otherwise client: send the doc-
ument assigned to the relationship on the Documents tab of the Debtor
Aging screen if available for the relationship, otherwise : send the doc-
ument assigned to the client on the Invoice Delivery panel with the
Invoice Delivery package

l Send from client, if available, otherwise relationship: send the doc-
ument assigned to the client on the Invoice Delivery panel if available, oth-
erwise send the document assigned to the relationship on the
Documents tab of the Debtor Aging screen with the Invoice Delivery pack-
age

l Send both if available: send the document assigned to the client on the
Invoice Delivery panel and the document assigned to the relationship on
the Documents tab of the Debtor Aging screen as available with the
Invoice Delivery package

Debtor Information Setup

The print Preference or the debtor must be set to Email in the upper fields of the Debtor Information
screen, and the Email address set in the Address panel of the Debtor Information screen must be set to a
valid email address for the debtor. Alternately, if the Inv Delivery option on the Debtor Contact screen is
selected, the Invoice Delivery package for the debtor is delivered to the Email address set up for the con-
tact instead of the email address for the debtor from the Address panel of the Debtor Information screen.
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The invoice delivery items to be delivered can be set for each individual debtor . On the Collections tab of
the Debtor Information screen, select the option to indicate that the invoice delivery items to be delivered:

l Delivery cover page & images

l Deliver nothing

l Deliver images only

l Deliver cover page only

System Preference Debtor rules/defaults, Defaults, Invoice delivery rule allows selecting one of these
options as the default for new debtors. When a new debtor is created, the invoice delivery option for the
debtor is set to the selected option by default.

Default Cover Page

The Invoice Delivery default cover page includes the lender address fields listed below, which are pulled
from the Identification/system constants, Name & address System Preference folder.

Preference Description

Address#1 Enter the first line of the lender address.

Address#2 Enter the second line of the lender address, if applicable.

City Enter the city of the lender address.

State Enter the state code for the lender address.

Zip code Enter the ZIP or Postal code for the lender address.

Adding an NOA Document to the Delivery

Invoice Delivery allows for a document to be included with each delivery package for a client/debtor rela-
tionship - this would typically be the signed notice of acknowledgment. The document to be included in
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the delivery must be saved as a Smart Word Document using the Smart Word Document Control Table
screen in the Tables module, and then the document must be attached on the Documents panel of the
Client Information, Debtor Information, or Debtor Aging screen.

You can limit the document category in which to select the NOA document. Set System Preference
Field/screen behavior, Client/debtor relationship, Document for NOA selection to the desired doc-
ument category. Available document categories are those previously configured in the Document Cat-
egories table in the Tables module.

To specify the document to be included with the delivery package:

1. Select the client line-item in the Client List screen

2. Click Client Aging in the Functions tab of the Client List screen. The Summary Aging screen opens.

3. Select the debtor line-item on the Summary Aging screen.

4. Click the Details button. The Debtor Aging screen opens.

5. Select the Documents tab.

6. Select the document in the NOA Document field on the Documents tab of the Debtor Aging screen.

7. Click the Modify button to save the document for the relationship.
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Annotation Watermark for Invoice Images

The capability to annotate or watermark images delivered through the Invoice Delivery module can be
configured in FactorSoft. The annotation or watermark text is set up in the Statement Text Table in the
Tables module and then selected at the lender-level by System Preference (see FactorSoft Help or the
FactorSoft Administrator’s Guide for more information on the Statement Text Table). The capability to over-
ride the lender selection at the client-level is provided.

System Preferences

See the System Preference descriptions in the Invoice Delivery Setup topic of this section for the System
Preferences related to invoice image watermarking.

Overriding the Lender Level Watermark for a Client

To override the lender selection, select the statement text name to use in the Watermark outgoing
invoices field on the Purchase info panel of the Client Information screen for the client.

Sample Watermark

Below is a sample watermark in center position, 15 point font size, red color, and .4 opacity set in System
Preferences > Data entry behavior, Invoice Delivery, Coverpage Settings folder.
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How It Works

Invoice Delivery is enabled through the Engine. When invoices are purchased in FactorSoft, if the batch
has images attached for a client that has Invoice Delivery enabled, the Engine process detects the batch
on its periodic query. If there are unattached images, Invoice Delivery holds delivery of the email and indic-
ates the condition with the message Invoice delivery waiting on unattached images & engine pro-
cessing on the Invoice Delivery Tab of the Monitor Service Queue screen and on the Client Transaction
screen for the Purchase transaction, as shown below. If all invoices have assigned images, the message
reads Invoice delivery waiting on engine processing.

NOTE
When Invoice Delivery is enabled for a client, but no images are included with a batch, the message
on the Transaction screen message is Invoice delivery not required.

In Client Transactions screen:

In the Activity Center:
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When images have been attached to all invoices in the batch, the email invoice packages are delivered
to the debtor contact, and the status message on the Transaction screen is updated to Invoice delivery
has been processed, as shown below, and the corresponding line-item on the Invoice Delivery tab of the
Monitor Service Queue screen is cleared.

In Client Transactions screen:
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In the Activity Center:

Invoice Delivery User Guide
Invoice Delivery

18 © 2022 Jack Henry & Associates, Inc. ®

FactorSoft™
v4.7



Attaching Unattached Images

Invoice Delivery is not executed on a batch until all of the images have been assigned to an invoice unless
specifically instructed to send batches with unattached images (see Send Batch with Unattached Images
below). To attach unattached images in a batch,
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1. Select the Attach Images to Posted Batches option in the File, Input menu of the FactorSoft Desktop
application.

The Posted Batches with Unassigned Images screen opens.

2. Select the purchase batch from the grid.

3. Click Process.

The Batch screen and Invoice Image screen for the batch are opened.

4. Select the invoice in the Batch screen grid to which the first image in the Invoice Image is to be
attached.

5. Select the image type, if required (i.e., Invoice or Support)

6. Click Assign.

7. Repeat these steps for all images/invoices.
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Send Batch with Unattached Images

You can send batches with unattached images via Invoice Delivery regardless of the current status.

CAUTION
When batches with unattached images are sent, this action cannot be
reversed

To send a batch with unattached images, click the Stop Waiting button on either the Monitor Service
Queue window or the Transactions tab on the Activity Center screen.

NOTE
Employees with access to the Administration module can also click the Stop Waiting button on the
Monitor Service Queue window when viewing all Invoice Delivery packages waiting to be processed.

When this button is clicked, Invoice Delivery sends only what is associated with the invoice. If no images
are associated, only the cover page is sent.

Resend Batch Images

To resend an Invoice Delivery package for a previously delivered purchase transaction, access the trans-
action on the Activity Center or Client Transactions screen and click the Resend Invoices button.

You can also resend Invoice Delivery for a specific debtor within a purchase batch:
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1. Select the client line-item in the Client List screen.

2. Click Client Transactions in the Functions tab of the Client List screen.

The Activity Center or Client Transaction screen opens.

3. Filter the results and select the purchase batch in which the Invoice Delivery package to be resent
was included.

4. Enter Invoice Delivery Reprint in the Action field and click the Action button.

The Invoice Delivery Reprint screen displays.

5. Select the invoice package to resend.

6. Click Resend.

All invoices associated with the debtor are resent.

NOTE
To resend only specific invoices in the package, click the View button. The invoice package dis-
plays as a .pdf, where specific invoices to resend to the debtor can be saved and resent.

Exclude a Batch From Invoice Delivery

FactorSoft provides the capability to mark a purchase batch to be excluded from Invoice Delivery. If the
user selects the Bypass invoice delivery option on the Purchase/Schedule Batch screen for the batch, it
will not be picked up and processed by the Invoice Delivery task of the Engine. However, the batch will be
available to be sent via Invoice Delivery by selecting the batch on the Transactions tab of the Activity
Center screen and clicking the Resend Invoice button (which will send all of the invoices in the batch
through Invoice Delivery).
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NOTE
This feature can be limited by Security Role.

Invoice Delivery Package

If the debtor Preference is set to Email, the package is delivered by Invoice Delivery via email to the email
address set on the upper fields of the Debtor Information screen. The Subject line of the email contains the
text set in System Preference Data entry behavior, Invoice Delivery, Subject Line, with the additional
invoice and/or PO# information determined by System Preference Data entry behavior, Invoice Delivery,
Subject line rule.
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The PDF attachment contains the cover page (as determined by System Preference Reports, Purchase
reports, Cover page Crystal Report module) and the invoice and supporting document image pages
associated with the batch or invoice, depending on the setting of System Preferences Include notice of
acknowledgment if available, Instructs the Engine to send one email per invoice, and Instructs the
engine to ignore supporting documents as attachments in the Data entry behavior, Invoice Delivery
folder.
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To customize the order of the documents, go to the Invoice Delivery tab of the Image Type Table Main-
tenance screen located at Tables > Data Entry > Image Type Table. Use Up and Down to arrange doc-
uments in the Invoice Delivery Package or check the "Exclude from... " box then select Modify to save
changes to the table and omit from attachments.

CAUTION
When upgrading to v4.2+, all current Image Types will be excluded except for the NOA and Written
Invoice. Therefore, it is recommended to review the Image Type Table and Invoice Delivery Tab determ-
ining which images should or should not be excluded from the Invoice Delivery Package and to estab-
lish the order that the image type should be included in the Invoice Delivery Package.
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Upon creation/setup of a new database, the Image Types Table > Image Type tab will automatically pop-
ulate with the following Default Codes and Images Types:

l 0=Invoice

l 1=Check

l 2=Support.

Users have the capability to create and establish additional Codes and Image Types as needed on the
Image Type tab. Once created, the new image type will appear on the other tabs.

Images can be printed, faxed or emailed. Using the Flagged option, you can select the images to be prin-
ted or emailed from the batch. When emailing multiple images, FactorSoft compresses the images into a
single attachment.

CAUTION
When a new Image Type is created in the Tables > Data Entry > Image Type Table > Image Type Tab,
the image type will automatically populate to the Invoice Delivery Tab and be set as Excluded from
Invoice Delivery. Default Image Types can not be deleted and additional Image Types can not be
deleted if they are associated with an image.

Upon set-up of Invoice Delivery, professional services may be required if the default Image Type Codes are incor-
rect.
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If the debtor Preference is set to Print, the package is delivered to a printer utilizing Print to be delivered by
whatever means the lender wishes. Note that Print must be installed and configured to enable delivery to
a physical printer through Invoice Delivery.

You can validate the delivery from Invoice Delivery from the Engine Administration module. Select the Mes-
sages page for the Created Date on which the invoices were delivered. Click the plus sign adjacent to the
desired entry to display the delivery information. The Addresses tab displays the email address or debtor
name (if printed) to which the package was delivered, and the Attachment tab displays the contents of
the delivered package.

Note also that the delivery status can be viewed in the Transaction Audit History screen, which is accessed
for a purchase transaction from the Activity Center or Client Transactions screen. Click the Audit button to
open the Transaction Audit History screen, and then hover the mouse-pointer over the Action column of
the Data Sent entry for the batch. The pop-up displays message created and sent date/time and delivery
status information, as pictured below:
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Invoice Delivery Reports

The following reports specific to the Invoice Delivery AddOn module are located in the Productivity menu
of the Reports module.

Invoice Delivery Batch Detail Report

The Invoice Delivery Batch Report, which is accessed from the Productivity menu of the Reports module,
list the Invoice Delivery related details of a single purchase batch. The report displays the batch level cre-
ation and updated dates and status of the Invoice Delivery package, as well as each individual debtor
package. Delivery details for each debtor include the delivery address and the attachments included in
the package.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
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Field Description

menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Batch# Enter the purchase batch number for the Invoice Delivery batch details to be displayed. This
field is required. The user can first create the Invoice Delivery Status Report to obtain the
batch number.

Report Sample
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Report Details

Column/Label Description

Header Section

Client Client’s Name

Batch No. Purchase Batch #

Post Date Post Date of the Purchase Batch

Trans-Status Status of the Purchase Batch

Invoice Delivery Package Section

Create Date Date the Invoice Delivery Package
was Created

Modified Date Date the Invoice Delivery Package
was Modified

Status Status of the Invoice Delivery Pack-
age

Message Header Section

Debtor Debtor’s Name

Create Date Date the Message Header was
Created

Modified Date Date the Message Header was
Modified

Status Status of the Message Header

Invoice Delivery Rule Debtor’s Delivery option:

1. Deliver cover page & Images

2. Deliver Nothing

3. Deliver images only

4. Delivery cover page only

Set at Debtor Information > Col-
lections Panel
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Column/Label Description

Delivery sent Date the Message was Sent

Delivery mode Mode of sending the Message

1. Email

2. Print

Delivery Status Status of the Message

Invoice Delivery Package Detail Section

Address Address that the Package was
sent to

Address Type

Attachment Attachments included in the
Invoice Delivery Package

Attachment Type Attachment Type

Reference Key Reference Key is the Image Key or
Document Key

File Name File Name and Location of the
Invoice Delivery Package Message

Security Roles

To generate the Invoice Delivery Batch Detail Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Productivity Reports > Print Invoice Delivery Batch Detail Report

Invoice Delivery Report

The Invoice Delivery Report is accessed from the Productivity menu of the Reports module. This screen is
used to generate the Invoice Delivery Exception report, which lists clients and debtors for which Invoice
Delivery was attempted, but not successfully completed.

The default report definition for this report is InvDelExcptRept.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the date
range to which to limit the report in the From and Thru fields.
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Field Description

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will print
Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set System
Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date Range
is set to Last Business Day. This function is only valid for Reporting Services reports when Use
last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Fields/Screen
Behavior > Miscellaneous > Use Client Search instead of drop downs is set to True.

Select the magnifying glass icon to open the Search window and begin typing the
client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction defined
on the Manage Users screen in the Admin module, the user will only be able to generate the
report within that office restriction. When the user generates a report, the office to which they
are restricted will be selected in the Office field by default and the user will not be able to
change the Office field when generating the report.
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Field Description

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access this
table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client Group
Codes.

Report Select the report format to be generated.

l Invoice Delivery Exception

l Invoice Delivery Exception by Batch

l Invoice Delivery Batches Waiting On Unassigned Images

Batch# Enter the batch number when requesting the Invoice Delivery Exception by Batch version of
the report.

Report Sample

Reports: Invoice Delivery Exception or Invoice Delivery Exception by Batch
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Report: Invoice Delivery Batches Waiting on Unassigned Images

Report Details

Column Description

Reports: Invoice Delivery Exception or Invoice Delivery Exception by Batch

Post Date Post Date of the Purchase Batch

Batch # Purchase Batch number

Invoice # Invoice number

User User who processed Purchase Batch
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Column Description

Failure Text Failure text indicating the reason the Invoice Delivery package did not
send successfully

Coverpage Location of the Invoice Delivery Cover Page

Report: Invoice Delivery Batches Waiting on Unassigned Images

Client Client’s Name

Post Date Post Date of the Purchase Batch

Batch # Purchase Batch Number

Security Roles

To generate the Invoice Delivery Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Productivity Reports > Print Invoice Delivery Report

Invoice Delivery Status Report

The Invoice Delivery Status Report, which is accessed from the Productivity menu of the Reports module,
lists batches by client on which Invoice Delivery packages have been sent or on which delivery was
attempted and displays the status of the delivery attempt. Other information listed includes the debtor
name, batch post date, invoice creation and modified dates, transaction and invoice package status,
debtor invoice delivery rule, and mode of delivery.
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Field Description

Report Template Lists any report template created to date. Select a template from the list to gen-
erate a report based on its saved display parameters. Type a new Report tem-
plate name and click Save to create a new template for this report, then Select
the template from the Templates tab and make any applicable parameter and
scheduling selections to complete the template.

Report Parameters

Field Description

Date
Range

Select the date to use for the report from the list:

l Today

l Yesterday

l Last Month

l Current month-to-date

l Year through last month-end

l Current year-to-date

l Specific date

l Set At Run Time (Web Template Only)

If the Specific date range option is selected, enter the beginning and ending dates of the
date range to which to limit the report in the From and Thru fields.

Last Business Day can be substituted for Yesterday. To enable Last Business Day, set System
Preference Identification/system constants > CLMS|Reporting Services > Requests > Use
last business day instead of yesterday in date range to True. The Yesterday option in the
Date Range field is replaced with Last Business Day, and reports printed on Monday will
print Friday’s data (assuming Friday was the last business day) instead of Sunday’s. Set Sys-
tem Preference Identification/system constants > CLMS|Reporting Services > Requests >
Saturday is a business day to True to consider Saturday a business day when the Date
Range is set to Last Business Day. This function is only valid for Reporting Services reports
when Use last business day instead of yesterday in date range is set to True.

Client drop-down to select the client for which to run the report.

For Client Search Window, available on SQL Reports when System Preference > Field-
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Field Description

s/Screen Behavior > Miscellaneous > Use Client Search instead of drop downs is set to
True.

Select the magnifying glass icon to open the Search window and begin typing
the client name.

Select Contains or Begins with to refine results. Search window will display up to 500
matches.

Click the red [x] icon to clear the Client field.

TIP
Choosing Contains will allow users to search by Client Code.

A/E Select the Account Executive (FactorSoft user) to which to limit the results in the report, or
leave blank to include all users. When a user is selected, the report is limited to clients that
have that user selected in the A/E field on the Control panel of the Client Information
screen.

To limit the A/E field to list only those users that have been marked as an A/E, use the fol-
lowing System Preference:

l Terminology > Select account executive based on check box: TRUE

Office Select the office to which to limit the report results. If the user has an Office restriction
defined on the Manage Users screen in the Admin module, the user will only be able to gen-
erate the report within that office restriction. When the user generates a report, the office to
which they are restricted will be selected in the Office field by default and the user will not
be able to change the Office field when generating the report.

Offices are defined in the Office table in the Tables feature. To access this table, on the File
menu, click Tables. Then, on the Client & Debtor menu, click Office.

Client
Group

Select the client group to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Value Select the specific client group value to which to limit the results in the report.

Client Groups are defined in the Client Group Code table in the Tables feature. To access
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Field Description

this table, on the File menu, click Tables. Then, on the Client & Debtor menu, click Client
Group Codes.

Format Select the report format to be generated.

l By Batch

l By Date

Batch# Enter the batch number when requesting the By Batch version of the report.

Show
Only Pro-
cessed
Batches

Select this check box to only include batches that have been processed in the report res-
ults.

Report Sample
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Report Details

Column/Label Description

Client Client’s Name

Batch No. Purchase Batch Number

Post Date Post Date of Purchase Batch

Trans Status Transaction status of Purchase Batch

Debtor Debtor’s Name

Create Date Create Date of Invoice Delivery Package

Modified Date Modified Date of Invoice Delivery Package

Status Status of building the Invoice Delivery Package

Invoice Delivery Rule Debtor’s Invoice Delivery Rule setting

Delivery Sent Date & Time that Invoice Delivery Package was sent

Delivery Mode Mode by which the Invoice Delivery Package was sent

Delivery Status Status on Sending the Invoice Delivery Package

Security Roles

To generate the Invoice Delivery Status Report, the following Security Role needs to be set to YES:

l Security Roles > Reports > Productivity Reports > Print Invoice Delivery Status Report
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